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Upgrading to Octel® 100 Version 3.2 from Lucent Technologies
Messaging 2000

This note provides the steps for upgrading systems currently running Lucent
Technologies Messaging 2000 to Octel 100 Version 3.2.

Steps for installing OS/2 Fix Pak 40 are also provided. You must install Fix Pak 40 before
you upgrade to Octel 100 Version 3.2, unless you migrated to a new PC.

Required Materials

The following materials may be required for the upgrade. Make sure that you have the
required materials available before beginning the upgrade:

• A medium you can use to back up files on the system, such as diskettes or a tape
backup device

• Any hardware required to upgrade the system, including voice or fax boards, RAM,
or a Sentinel device, as well as accessory tools you may need, such as a
screwdriver

• A sentinel upgrade utility (SUU), if adding optional modules

• An anti-static wrist strap, if you will be handling voice or fax boards

• Octel 100 v3.2 Upgrade CD-ROM

• The PC manufacturer’s documentation, if you are upgrading RAM

• Octel 100 Version 3.2 Implementation and Service Manual

 Procedures in this note assume that the hard drive on which the system is installed is
drive C, that any additional hard drive that may be installed is D, that the disk drive is A,
and that the CD-ROM drive, if installed, is E. Drive designations on the specific PC on
which you are working may vary. Confirm the appropriate drive letters, when necessary,
in procedures provided in this note.

WARNING: On systems that have custom phrase files in the ENGLISH1.O32 or
ENGLISH2.O32 files, you must back up those phrase files, then
manually restore the custom phrases using V-Edit after the upgrade is
complete. Therefore, you must compile a list of the custom phrase
numbers before you perform the upgrade.
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Installing OS/2 Fix Pak 40

OS/2 Warp Fix Pak 40 must be installed on PCs running OS/2 Warp 3.0. IBM issued Fix
Pak 10 to address OS/2 Warp 3.0 operating system anomalies.

WARNING: If you migrated to a new PC or you purchased the upgrade to OS/2
Warp 4.0, you must NOT install OS/2 Fix Pak 40. Fix Pak 40 should only
be installed on systems running OS/2 Warp 3.0.

To install OS/2 Warp Fix Pak 40:

1. Shut down the messaging system if it is running:

a. Log into the messaging system as a Level 2 or 3 supervisor.

b. To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

c. Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

2. Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” in the CD-ROM drive.

3. Open an OS/2 window if one is not already open.

4. From the C: prompt, type E: and press <ENTER>.

5. From the E: prompt, type instfp40 and press <ENTER>. The OS/2 Warp Fix Pak
40 install begins.

6. When the file update is complete, the OS/2 window displays a message that the Fix
Pak 40 file transfer is complete. Press any key to continue.

7. Remove the CD-ROM from the CD-ROM drive.

8. To close the OS/2 window, type EXIT and press <ENTER>.

9. Restart the PC:

a. Click the right mouse button on an empty area of the OS/2 desktop and select
Shut down from the menu that displays.

b. When you are prompted whether you want to close all windows and active
programs, click OK.

When prompted to shut down or reboot, press <CTRL+ALT+DEL> to restart the PC.
Once the PC restarts and the OS/2 desktop displays, complete the procedure to perform
the upgrade to Octel 100 Version 3.2.
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Performing the Upgrade to Octel 100 Version 3.2

Complete the following procedures to successfully upgrade to Octel 100 Version 3.2:

1. Shut down the M2000 system if it is running:

a. Log into the messaging system as a Level 2 or 3 supervisor.

b. To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

c. Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

2. Run Quick Assist in Update (Partial) mode. See the procedure, “Using Quick Assist
to Recover System Files,” in Chapter 23, “Maintaining the System,” in the
Implementation and Service Manual.”

3. Shut down any open applications (for example, UPS, SMDI) and windows except the
OS/2 desktop, the LaunchPad, and the OS/2 window:

a. Press <CTRL+ESC> to open the Window menu.

b. Highlight any application you see with the exception of the OS/2 desktop or the
LaunchPad.

c. Click the right mouse button once on the open application.

d. Select Close.

e. Repeat steps 3a – d for each open application.

4. Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” in the CD-ROM drive into the
CD-ROM drive. If you have just installed OS/2 Warp Fix Pak 40, the CD-ROM
should still be in the CD-ROM drive.

5. In the OS/2 window, from the C:\ prompt, type E: and press <ENTER> to change
to the CD-ROM drive.

 Do not attempt installation from the full screen OS/2 window because the installation
process will run in the background, and the installation screens will not be visible to
you. Consequently, you cannot follow the prompts.

6. From the E:\ prompt, type CD VM then press <ENTER>. The \VM directory prompt
displays.

7. From the \VM directory prompt, type INSTALL and press <ENTER>. The message
“Setup is initializing, please wait...” displays.

8. A window displays which briefly describes the installation procedure. To continue
installing, click Continue or press <C>. The installation program presents a list of
drives from which you can select.
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9. Select the drive on which the current Messaging 2000 system is installed. Use the
down arrow key to highlight the appropriate drive, then click OK. (Drives A and B are
disk drives.) The system prompts whether you want to install the system to the \CVR
directory on the specified installation drive.

 

10. Click Yes to install the system to the \CVR directory and continue the installation
process. If you click No, you are prompted to enter a destination directory.

 To facilitate system maintenance, it is recommended that you do not change the
default installation directories.

11. You are prompted whether you want to back up the voice mail system. If you select
Yes, the system backs up the CVR, CVR1, and REPAIR directories to the
\OSP_OLD directory, which contains CVROLD, CVR1OLD, and REPROLD
directories, respectively. It is strongly recommended that you select Yes back up the
voice mail system.

12. Wait while the system prepares to load files. A dialog box with installation options
and space requirements displays. The Space Requirements section of the window
displays the disk space required, based on the selected options, the space
availability, and the installation and boot drives.

 

13. Under Installation Options, leave all of the options selected:

• Program Files – Includes the executable files needed to run the messaging
system.

• Utilities – Contains the files necessary to run system modules, such as DialPlan
and Integrator.

14. Under Voice Files, select the language(s) that you are installing. Note that the
Sentinel attached to the PC controls the number of allowed languages allowed.

15. Under Voice Drivers, select the type of voice board installed in the system PC from
the drop-down menu.
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16. Under Serial Integrations, verify that the option displayed is correct. If it is not, select
the appropriate option from the drop-down menu.

 You can exit the installation at this point by clicking Exit. After you select Install, you
cannot exit the installation process.

17. Click Install to install Octel 100 based on the selections.

 A small display appears to the left of the Disk Prompt window to show the
progression of the installation process. The graph represents the percent of hard
drive space and memory being used, as well as the progression of each file as it is
copied from the disk to the hard drive. If the Low icon comes on during installation,
do not be concerned.

18. When the system then prompts you to indicate whether you want the messaging
system to launch automatically upon bootup, click Yes. This configures Octel 100 to
launch each time you restart the PC and allows you to run third-party maintenance
utilities from the RUNVM.CMD file. For information on modifying the RUNVM.CMD
file, see the topic, "Verifying Files After Installation," in Chapter 6, “Installing the
Software,” in the Implementation and Service Manual

 

19. If you selected Yes in step 18, you are prompted to indicate whether you want the
UPS monitor to load automatically upon boot up. Select Yes if the UPS is currently
integrated with the messaging system or you are planning to run UPS integration so
the UPS monitors messaging system status to recognize a potential interruption in
operation before it occurs. For additional information on the UPS monitor, see
Chapter 11, “Integrating with an Uninterruptible Power Supply,” in the
Implementation and Service Manual.

 Select No if you do not want the UPS monitor to load upon boot up.

 Programs that load prior to the desktop coming up under OS/2, such as UPS, display
a default OS/2 icon on the desktop rather than the custom icon.

20. If you installed a serial integration, you are prompted whether you want the serial
integration to launch automatically on bootup. Click Yes.

21. A dialog box displays informing you that the file installation is complete. Click OK to
continue with system configuration.
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22. The Installation Setup Utility dialog box displays.

 

23. Click Done to exit the Installation Setup Utility dialog box. The system then
completes the installation. When installation is complete, the system displays a
message reminding you to restart the computer for any changes to take effect. Do
not reboot at this time.

24. To close the dialog box and return to the OS/2 window, click OK.

25. To exit the OS/2 window, type EXIT then press <ENTER>.

26. Remove the CD-ROM.

27. Shut down the PC:

a. Select Shutdown from the LaunchPad. When you are prompted whether you
want to close all windows and active programs, click OK.

b. When prompted to shut down or reboot, press <CTRL+ALT+DEL> to reboot the
PC. If the messaging system is configured to launch automatically on bootup, it
launches. Otherwise, the OS/2 desktop displays.

 If the voice system does not start up as it should, contact a technical support
representative immediately.

28. If you were not using custom phrase files in the [LANGUAGE]1.O32,
[LANGUAGE]2.O32, or [LANGUAGE]3.O32 files, the upgrade is complete. If you
were using custom phrase files, you must use V-Edit to restore the phrases
individually from the back \CVR directory. For information on using V-Edit to restore
phrases, see the heading “Adding Segments to Phrases” in Chapter 15, “Recording
and Editing Prompts,” in the Implementation and Service Manual.

 Make sure you restore the phrases to the correct phrase number.
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Issues Addressed in Octel 100 Version 3.2

The following program changes have been made in Octel 100 Version 3.2:

• Three parameters new are now supported by the ICONFIG utility: MWLWAIT,
NAKQUEUE, and MWLQSIZE so that they will be saved in the SI.CFG file and no
longer be overwritten when ICONFIG is run.

• A problem was addressed where an access violation occurred while attempting to
print a report while a different report is still in progress.

• Corrected an issue where DID Calls to a busy station failed integration.

• Corrected an issue where changes to Greeting by Port setup changes were always
properly saved when the “Copy to Port…” option was used.

• Corrected an issue where messaging system database files were not always
accessible after the messaging system was shut down on systems with Visual
Mailbox.

• Corrected the Go to Automated Attendant, Get Mailbox and Go to Voice Mail, Get
Mailbox inband templates for the Lucent Legend and Partner switches so the correct
action is executed.

• The OS/2 option to create an archive at each system restart is now enabled. This
allows the most recent desktop settings to be recovered if necessary.

• Corrected an issue where an incorrect prompt was voicing for the Go to VM, Get
Mbox function.

• Corrected an issue where ICONFIG settings were not being retained after an
upgrade.

• Improved inband templates for serial integrations.

• The UPS Integrator can now be minimized to an icon and resized properly.

• An issue with OS/2 that could cause incomplete shutdowns has been addressed by
upgrading to OS/2 FixPak 40 on existing systems.

• Corrected incorrect MI codes in SWDATA.TXT for Mitel SX2000 COV integration.

• An issue was corrected where a blank dialog box displayed during a CEO to Octel
100 upgrade.

• Corrected an issue where, when upgrading from OPC 1.02, the dialog box instructing
the installer to review the inband templates and make sure they are configured
properly did not display.

• Corrected an issue where the Dialogic D/42D-NS was not receiving the proper
Caller-ID on the new Norstar Compact ICS KSU.

• Modified Configuration Note for the NEC 2000 to include requirement of adding –
PXXXX to NEC.EXE file.

• Modified the SWDATA.TXT file to correct incorrect default codes for some functions
on Lucent switches.

• Updated OctelNet to send more descriptive return codes for administrative
responses.

• Corrected an issue where message confirmations to 10-digit mailboxes on an
OctelNet node were not working properly.

• Corrected an issue in SMDI.TPT that generated an error message.
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• Added MWI refresh. See, “Refreshing Message Indicators,” in Chapter 23,
“Maintaining the System,” in the Implementation and Service Manual.”

• Corrected an issue where the runvfs.cmd could not be shut down.

• Added Serial Number parameter to Networking parameters in System Setup. See
the Serial Number parameter description in Chapter 13, “Setting Up the System,” in
the Implementation and Service Manual.”

• Corrected an issue where the System Setup utility could not be accessed from the
desktop when the OS/2 System Setup Icon View was open.

• Tone tables have been added for the Lucent Prologix switch.

• Changed the SI.CPP file to use a 4-digit year instead of 1 2-digit year. The result is
the Serial integration log now correctly processes dates after 1999.

• Addressed an issue where NameNet entries were sometimes being deleted in
isolated situations.

• Corrected an issue that caused an incorrect time to be voiced when a subscriber
received a message that was sent with Future Delivery to a distribution list.

• Added new D42NS.FWL file.

• Corrected an issue where the Mailbox Information Report was not correctly updating
the Date of Last Use parameter.

• Corrected an issue where users cannot send messages to an OctelNet node if the
number of retries has been exhausted by administrative calls to the note.

• Removed support for the MD110 integration.

• There is a limitation on the Norstar switch that only permits 32 message indicator
requests to be turned on a particular channel. This release of the Octel 100
overcomes this limitation.


